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Sadan logger du pa med din Tl-konto

Hvis du vil bruge TI-SmartView™-emulatorsoftwaren til MathPrint™-lommeregnere,
skal du logge ind pa din TI-konto.

1. Start TI-SmartView™-emulatorsoftwaren til MathPrint™-lommeregnere.

Hvis det er fgrste gang, softwaren startes, vil du blive bedt om at acceptere
licensen, politikken om beskyttelse af personlige oplysninger og
onlinebrugsbetingelserne.

" X

W TExAs INSTRUMENTS

By using the application, you indicate your agreement with the
terms and conditions of the License, TI's Privacy Policy, and TI's
Online Terms of Use.

DECLINE  ACCEPT

Klik pa Accept.
2. lindlogningsskeermbilledet skal du klikke pa LAUNCH SIGN IN.

= X

Please sign in to your account to continue.

gz
PURCHASE LICENSE LAUNCH SIGN IN

Bemaerk: Hvis du skal kgbe en enkeltbrugerlicens, skal du klikke pa PURCHASE
LICENSE.

Hermed dbnes indlogningssiden for Texas Instruments i din browser. Gennemfgr
indlogningsprocessen med en Google-konto eller med den e-mailadresse, der hgrer
til din Tl-konto.
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x
Please sign in to continue

%3 TEXAS INSTRUMENTS

SIGNIN

(© sovmwmicooae

Or sign in with email

 Email (user name) ———————————————————

Nar du har valideret din konto, vises der en gennemfgrelsesmeddelelse i
browseren, og softwaren dbnes.

Visning af licenseringsoplysninger
Mens du er logget ind, kan du se oplysningerne om din licens.

» Ga til Help > License Info.

= %
Account Info
email@domain.com

Subscription Expiration
2026-12-30

Session Expiration
6 Days 23 Hours 56 Minutes

Kontooplysninger: E-mailadresse pa den aktuelle bruger.

Udlgbsdato: Udlgbsdato for den aktuelle softwarelicens.
Session Expiration: Resterende tid i den aktuelle session.

Mens softwaren bruges, opretter den forbindelse til licenseringssystemet hvert 15.
minut. Hvis brugeren gar offline pa noget tidspunkt, vil softwaren kgre i syv dage
fra sidste gang, den oprettede forbindelse.

Sadan logger du ud af din konto
1. Ga til Help > Sign Out.
2. Klik pa SIGN OUT.

Softwaren vil lukke, og der dbnes en browserfane pa indlogningssiden.
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Hvis du logger ud, gemmes den aktuelle tilstand, og licensen frigives blandt de
tilgaengelige pladser. Hvis du lukker softwaren ved hjzlp af File > Exit eller

lukkeknappen , medfgrer det ikke, at en bruger automatisk bliver logget ud, og
licensen frigives.
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Introduktion til TI-SmartView™-emulatorsoftware til
MathPrint™-lommeregnere

Med TI-SmartView™-emulatorsoftwaren til MathPrint™-lommeregnere kan du vise en
Tl videnskabelig lommeregner til hele klassen.

Regnerens Emulator-vindue

Lader dig:

e Vealge emulator

{

% — Veelg den emulator, du vil arbejde med.
—  TI-30X Plus MathPrint™
— TI-30X Pro MathPrint™
— TI-30XS MultiView - TI-30XB MultiView™
- TI-34 MultiView™
e Skjule/vise stor emulatorvisning

— Vis Fuld emulatorvisning med eller uden et Stort
Skaermvisningspanel.

e Skjule/vise tastetrykhistorik

— Viser billeder af tastetryk, sa elever kan fglge med, nar tasterne
trykkes.

e Starte et separat Skeermfangstvindue

— Indfang og gem emulatorskaerme som computerfiler, ligesom ved Tl
Connect™ CE-skeermfangst.

Se: Sadan bruges Emulator-vinduet til at forbedre dine preesentationer for klassen.

Introduktion til TI-SmartView™-emulatorsoftware til MathPrint™-lommeregnere
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Ibrugtagning: Valg af emulatortype

Fgrste gang TI-SmartView™ til MathPrint™ startes pa din computer, vises en
meddelelsesdialogboks.

{5 Available Emulators % Veelg emulatortypen ved hjelp af rullemenuen,
og velg OK.
Select a default emulator: Den valgte emulator vises til din fgrste

preesentation.

Ti-30X Plus MathPrint

TI-30X Pro MathPrint re using the
TI-30XS MultiView ar.

Ti-34 MultiView

TI-SmartView™ til MathPrint™ genstartes altid i den seneste softwaretilstand. Fra
softwaren kan du @ndre standardemulatoren.

Se: Sadan vaelges en emulatortype.

Den seneste emulatortype i visningen bliver standard, og den seneste
tilpasning af vinduet vises i henhold til dine seneste indstillinger.

Se: &£ndring af stgrrelsen pa TI-SmartView™ Emulators store visningsskeerm
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Sadan bruges TI-SmartView™ Emulator-vinduet til
MathPrint™-lommeregnere

TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregneren indeholder vaerktgjer,
du kan bruge til at indtaste beregninger .

Brusrenans  TIF30X Pro DEG

MathPrint

Key Press History
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Dele af TI-SmartView™ Emulator-vinduet

o

File Edit View Actions Help

Menulinje — Brug disse menuer til at udfgre alle emulatorfunktioner, herunder:

o File (Fil) — luk eller afslut * Actions (Handlinger) — sdsom
skaeermfangst
e Edit (Rediger) — inklusive
kopier tast som skrifttype
e View (Vis) — skift
visningerne

e Help (Hjeelp) — Hjeelp og links

Bemaerk: Du kan fuldfgre de fleste af handlingerne i disse menuer ved at klikke
pa ikoner pa veerktgjslinjen.

Toolbar (Veerktgjsbjzelke) — Brug disse veerktgjsbjzelkeikoner til at:
e Vazlge en anden regnermodel

e Skift mellem at skjule og vise Stor Visningsskeerm, og sla Tastetrykhistorik
til eller fra

¢ Indfang aktuel emulatorskaerm

Vealg Emulator- og Veerktgjslinje-placeringer

b
e Emulator position Left/Right (Emulatorplacering Venstre/Hgjre) E—I — til
at skifte mellem venstre- og hgjrehandsvisning af lommeregnerens skarm.

Dette er bekvemt, nar der projiceres pa et interaktivt Whiteboard.

e Tool Bar Top/Bottom (Veaerktgjsbjaelke @verst/Nederst) EI — til at skifte
veerktgjslinjen mellem @verst og nederst pd skeermen. Dette er bekvemt, nar
der projiceres pa et interaktivt Whiteboard.

Bemazerk: Du kan aendre det visuelle layout og/eller placering af elementer for at
optimere adgang, specielt ved brug af et interaktivt Whiteboard.

Emulator-panel — Brug dette panel til at vise den fulde emulator, eller kun
visning af emulator-tastaturet.

Stor Visningsskarm-panel/Tastetrykhistorik-panel — Brug dette panel til at vise
en stor version af regnerens skaerm og/eller til at vise tastetrykhistorik.

Du har fglgende visningsmuligheder:

e Kun Stor Visningsskaerm e Kun Tastetrykhistorik

e Stor Visningsskaerm +

Tastetrykhistorik e Skjul Stort Visningsskaerm

6]

/Andre stgrrelse pa Paneler — Klik og traek pa den lodrette bjaelke pa siden af
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| panelet for at sendre stgrrelsen.

Sddan bruges TI-SmartView™ Emulator-tastaturet
Musen overtager fingerens rolle med at trykke pa computerens tastatur.

Klik pa tasterne pa TI-SmartView™ til MathPrint™-emulatoren, som du ville trykke pa
tasterne pa den videnskabelige lommeregner.

Du kan holde en piltast nede for at rulle markgren kontinuerligt.

Nar du bruger en piltast til at flytte markgren, kan du holde tasten nede og rulle
kontinuerligt med markgren i stedet for at skulle trykke pa tasten hele tiden. |
tastetrykhistorikken har ikonet for repeterende piltast et ursymbol tilfgjet.

Ved at trykke pa en piltast mange gange i traek vises en pil med en optzlling af
gentagelserne.

Nar du trykker pa en piltast flere gange efter hinanden, vises en piltast i

tastetrykhistorikken; denne piltast DO har et tal vedhaftet, som viser antal gange der
blev trykket pa den pageaeldende piltast.

Traekke og slippe en skaerm til en anden applikation

Du kan traekke og slippe og indsaette enhver skeerm i TI-SmartView™-emulatoren til
MathPrint™-lommeregnere til en anden applikation.

De skaerme i TI-SmartView™-emulatoren til MathPrint™-lommeregnere, som kan
traekkes og indsaettes, omfatter fglgende:

e Skaermen over tastaturet i Emulatorpanelet.
e Stor Visningsskarm-panel

e Gemte eller ikke-gemte skeermfangster i Skeermfangstvinduet

Sadan bruges TI-SmartView™ Emulator-vinduet til MathPrint™-lommeregnere 8



Nulstilling af emulatoren

Sadan nulstilles emulatoren:

1. Klik pa Actions (Handlinger).

2. Klik pa Reset Emulator (Nulstil emulator).
3. Klik pa Reset (Nulstil).

= =)

Reset Emulator?

Resetting the emulator will overwrite all the

contents of the current emulator state.

Do you want to reset the emulator?

CANCEL RESET

.

Nulstilling af emulatoren:

e Overskriver den nuvaerende emulatortilstand
e Rydder tastetrykhistorik
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Lagring og indlaesning af MathPrint™ Emulator Tilstand

Nar du gemmer MathPrint™-emulatortilstanden, oprettes en fil, der gemmer
emulatorindstillingerne med alle de @&ndringer, du har foretaget.

Du kunne for eksempel gnske at opsaette en praesentation for en klasse ved at indtaste
data i en dataeditor og funktioner i f(x) og g(x). Hvis du har gemt a&ndringerne i en
emulatortilstandsfil, indlaeser du blot filen for at vise prasentationen. Hvis du vil
oprette forskellige praesentationer til forskellige klasser, kan du oprette flere
emulatortilstandsfiler.

Bemaerk: Tastetrykhistorikken, skaermfangstbillederne, emulatorvisningen og
emulatorstgrrelsen gemmes ikke i emulatortilstandsfilen. Bemaerk, at MathPrint™-
emulatortilstandsfilerne kan vaere store. Kontakt IT-afdelingen, hvis din lagerkapacitet
er et problem.

Lagring af MathPrint™-emulatortilstand

Styring, lagring og indlaesning af en emulatortilstandsfil er kun tilgaengelig for
MathPrint™-emulatorer. TI-30X Pro MathPrint™-emulatortilstandsfilen kan kun
indlaeses pa TI-30X Pro MathPrint™-emulatoren.

Bemaerk: TI-30X Plus MathPrint™-emulatortilstandsfilen kan kun indlaeses pa TI-30X
Plus MathPrint™-emulatoren.

1. Klik pa Actions (Handlinger) > Save Emulator State... (Gem emulatortilstand)....

B TI-SmartView™ for MathPrint™ calculators

File Edit View Actions Help

Capture Screen

Save Emulator State...

Load Emulator State..

v was _op  setes

(B B

2. | dialogboksen:
a) Naviger til den mappe, hvor du vil gemme MathPrint™-emulatortilstandsfilen.
b) Skriv et filnavn. Brug et navn, der beskriver MathPrint™-emulatortilstanden.
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Bemaerk: MathPrint™-emulatortilstandsfiler har et forudkonfigureret filnavn
med filtypenavnet *.s3l, som angiver den TI-30X Plus MathPrint™-
lommeregner-emulatortilstand, der oprettes af TI-SmartView™ MathPrint™-
emulatorsoftwaren. Filtypenavnet for TI-30X Pro MathPrint™-lommeregner-
emulatortilstanden er *.s3r.

c) Klik pa Save (Gem).
Indlzesning af en MathPrint™-emulatortilstand

Da MathPrint™-emulatortilstandsfilerne er specifikke for hver lommeregnermodel, kan
der kun indlaeses en emulatortilstandsfil for den aktive model.

1. Klik pa Actions (Handlinger) > Load Emulator State (Indlaes emulatortilstand).

B TI-SmartView™ for MathPrint™ calculators

File Edit View Actions Help

Capture Screen

Save Emulator State. DEG
PRSI | |

= Load Emulator State...

Reset Emulator

B
RIS

€ 8

2. | dialoghoksen:

a) Naviger til den mappe, der indeholder emulatortilstandsfilen.

Bemaerk: Kun MathPrint™-emulatortilstandsfilerne for den aktive
lommeregnermodel vises.

b) Klik pd MathPrint™-emulatortilstandens navn for at fremhaeve det.
c) Klik p3 Open (Abn).
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Sddan valges en visningsindstilling

Du kan tilpasse din skaerm til at vise eller skjule valgfrie paneler eller sendre de
informationstyper, der vises i hvert panel. Som standard viser TI-SmartView™-
emulatorsoftwaren til MathPrint™-lommeregnere Emulator-vindue til lommeregneren
pa Stor Visningsskeerm.

Sadan vises regnerskaermen

1. Klik pa for at 2. Klik pa igen for at
skjule det store vise det store skaermvisningsskaerm-panel.
skeermvisningsskaerm-
panel.

Fle  Edit

EE

Sadan veelges en emulatortype

Klik pa ned-pilen pa for at vaelge en emulatortype.

TiI-30X Plus MathPrint

o TI-30X Pro MathPrint ‘
TI-30XS MultiView
TI-24 MultiView

Hver emulatortype viser dens relevante regnermodel.
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Sadan zendres regnerens forplade

Sadan skifter du forpladen:

1. Klik pa View (Vis).

2. Hold markgren over regnerens forplade.

3. Klik pa et navn pa en regnerforplade.

Lys Mgrk Kontur
B v wsrwes TI-30X Pro % rovswsmwens 11-30X Pro B s wsmowenrs T1-30X Pro
MathPrint MathPrint MathPrint
.
quit insert quit insert quit insert
ol .| moc] [dete -
math math | | data - [math] (ot | .
[804r  vector random expr-eval random  expr ector  random  expr-eval
3 I [E e e 15| e || o e ] (158 [ome] (o]
complex num-solv poly-solv  sys-solv poly-so complex num-solv poly-solv  sys-solv 9%
- & (&) (][ + ]
constants  op setop setop
x
convert  basen <0
E F o
(5 | 6|
B 4 fard
EEER
reset answer reset y answer

-nnmm o | @ o

Vise eller skjule Tastetrykhistorikken

Klik pa for at vise eller skjule tastetrykhistorik.
Klik pa CLEAR (RYD) i panelet ved siden af Tastetrykhistorik for at rydde historikken.
o (235
Key Press History m
E «Q F
[5][-][6]
€ Klik her, og traek for @ Klik her, ndr du Klik her for at rydde
at eendre stgrrelsen har valgt taster, Tastetrykhistorik.
pa Tastetrykhistorik- for at kopiere
panelet. skrifttype som
grafik.
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Nar du trykker ryd, vil du se denne informationskasse:

r ~
ED Key Press History [iE-J

Are you sure you want to clear the history?

CANCEL CLEAR

Kopiering af tastetrykhistorik til en anden applikation

b

Du kan kopiere alle eller kun en markeret del af tastetrykhistorikken til en anden
B

applikation som et tekstbehandlingsprogram. Du kan kopiere tastegrafikken ,
som den vises i tastetrykhistorikpanelet, eller du kan kopiere tastetrykkene som
skrifttypeteksttegnene (5] (=] [6).

Bemaerk: Nar du kopierer taster som teksttegn i en skrifttype, anvender de pagaeldende
tegn skrifttypen TI-30X Pro Key. Kun skrifttyper for primare taster indsaettes. Skrifttyper
for sekundzere taster kan ikke indsaettes fra funktionen til kopiering som skrifttype i TI-
SmartView™. Du kan indsaette sekundzere funktioner manuelt ved hjzlp af den
installerede skrifttype. Denne skrifttype installeres automatisk pa computeren, nar du
installerer softwaren TI- SmartView™ til MathPrint™-lommeregnere. Skrifttypen har
alle TI-30X Plus-tastskrifttyper som underseet til TI-30X Pro-tastskrifttyper.

Sadan kopieres taster som grafik eller teksttegn i en skrifttype

1. Marker tasten(erne), du vil kopiere.
For at veelge taster i Tastetrykhistorik-panelet, bruges en af fglgende metoder:

Tast Metode
— En enkelt tast: Klik pa en tast.

—  Flere taster: Klik pa en tast.

Tryk og hold Ctrl pa din computers
tastatur.

Klik pa andre taster for at veelge flere
taster.

— Flere taster i en sekvens: Klik pa en tast.

Tryk og hold Shift pa din computers
tastatur.

Tryk pa en anden tast.

Bemaerk: Dette giver dig mulighed for
at veelge disse to taster, plus alle
tasterne mellem dem.

— Alle taster: Kilk pa en tast.
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Tast Metode

Hgjreklik.
Klik Veelg alt.

Bemaerk: Sadan ser en tast ud, fgr og efter du veelger den.

For: Efter:

B B

(2] [2]

2. Velg taster
3. Klik pa Edit (Rediger) > Copy (Kopier) (for at kopiere taster som grafik).

eller

Klik pa Edit (Rediger) > Copy As Font (Kopier som skrifttype) (for at kopiere taster
som skrifttypetegn) (5] =] (6].

4. Skift til en anden applikation.

5. Indszt tasterne pa den korrekte plads.
Bemaerk:

¢ Du kan ogsa traekke de markerede taster til den nye applikation som grafik.

e Du kan ogsa @ndre stgrrelsen pa tastegrafikken, efter du har indsat dem i en ny
applikation.

e | visse applikationer kan de indsatte tegn blive vist som den skrifttype, der er
aktiveret pa det pagaeldende sted, sa de overhovedet ikke ligner taster pa en
videnskabelig lommeregner. Anvend om ngdvendigt skrifttypen TI-30X Pro Key pa
tegnene. Se hjlpefilen til den destinationsapplikation du benytter for at fa
oplysninger om, hvordan en skrifttype anvendes pa tegnene.
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Andring af stgrrelsen pa TI-SmartView™ Emulators store
visningsskaerm

Klik pa og traek i kanten af Stor Visningsskaerm-panelet for at andre stgrrelsen.

B TI-SmartView™ for MathPrint™ calculators

10 x|

File Edit View Actions ]

B :maa @

Grceremmss TIR30X Pro

MathPrint

DEG

o

—
(3] ][] [
)
[t ] ]|
2=

e

A [

Key Press History ‘[

oft

(o] (0[] [zne]

Bemaerk: Alle disse er venstre/hgjre-handlinger, undtagen Tastetrykhistorik, som er
traek op eller ned for at sendre stgrrelse.

Placering af Emulator og Veerktgjslinjer

=g ‘ Emulator position Left/Right (Emulatorplacering Venstre/Hgjre) — til at
skifte mellem venstre- og hgjrehandsvisning af den videnskabelige
lommeregners skaerm. Dette er bekvemt, nar der projiceres pa et
interaktivt Whiteboard.

= Tool Bar Top/Bottom (Vaerktgjsbjzelke @verst/Nederst) — til at skifte
vaerktgjslinjen mellem gverst og nederst pa skaermen. Dette er bekvemt,
nar der projiceres pa et interaktivt Whiteboard.
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Altid forrest

Vealg denne mulighed i Visningsmenuen for at holde vinduerne for TI-SmartView™-
emulatoren til MathPrint™-regnere foran ethvert andet dbent
computersoftwarevindue. Svarende til at have regneren liggende pa dit skrivebord,
oven pa dine papirer! Placér vinduet pa din computers skrivebord, hvor det ligger bedst
som "Altid forrest."

Deaktivér "Altid forrest," fravaelg menuemnet i Visningsmenuen. Der er ikke noget
veerktgjslinjeikon til denne funktion, og ingen anden indikator end krydset i menuen nar
den er aktiv.

Noter:

Vinduet for TI-SmartView™-emulatoren til MathPrint™-lommeregnere og
Skeermfangstvinduet vil begge vaere "Altid forrest" og skifte til forrest afhaengigt af
deres placering.

"Altid forrest." anbefales ikke ved fuld skeerm, da alle andre vinduer vil vaere bag TI-
SmartView™-emulatoren til MathPrint™-lommeregnere.
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Sadan bruges skaermfangst

Du kan indfange den aktuelle specifikke lommeregnerskeerm ved hjzelp af
skeermfangervaerktgjet i TI-SmartView™-emulatoren til MathPrint™-lommeregnere.

Sadan bruges skeermfangst:

» Klik pa . pa veaerktgjslinjen.

Dette vindue vises:

"I TI-Smartview Sc
File Edit View Actions
1

5
2, (2x+1)
[8+[18
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Dele af Skaermfangstvinduet

o

Fangst

Klik her for at tage en emulator-skeermfangst.

Actions (Handlinger) > Capture Screen (Indfang skaerm)
Bemazerk: Der bliver automatisk fgjet en ramme til hvert
billede, nar du indfanger det, men du kan fjerne rammen ved
at klikke pa View (Vis) > Hide Screen Capture Borders (Skjul
Skaermfangstrammer). (Hvis du har flere billeder, fjerner dette
rammen fra hvert billede).

Med skaermfangst kan du:

e indfange op til 44 skeerme ad gangen, (for at indfange
yderligere billeder, slet billeder fra Skeermfangsvinduet)

e automatisk gemme skaermfangster i hukommelsen, indtil
du lukker det primaere vindue i TI-SmartView™ til
MathPrint™-lommeregnere.

At lukke Skaermfangster udlgser en prompt om at gemme

dine skeermfangster. Du kan starte en ny Skaermfangstsession

under en session i TI-SmartView™ til MathPrint™-
lommeregnere.

Save (Gem)

Klik her for at gemme udvalgte skeermfangster.
File (Fil) > Save As (Gem som)

Copy (Kopier)

Klik her for at kopiere udvalgte skeermfangster til
udklipsholderen.
Edit (Rediger) > Copy (Kopier)

Delete (Slet)

Klik her for at slette udvalgte skaermfangster.
Edit (Rediger) > Delete (Slet)

® O OO

Resize (Tilpas
stgrrelse)

Forskyd prikken langs med bjzlken, for at justere stgrrelsen
pa den nuvaerende skaermfangsts forhandsvisning.

View (Vis) > Scale Screen Captures (Skaler Skaermfangster)
Bemaerk: Skeerme gemmer procentdelen i visningen.

6/

Rename
(Omdgb)

Omdgb skaermfangsten ved at markere titlen og taste et nyt
navn

o

View (Vis)

Vis skaermfangster her.

Traekke og slippe en skaerm til en anden applikation

Du kan traekke og slippe og indsatte enhver skeerm i TI-SmartView™-emulatoren til
MathPrint™-lommeregnere til en anden applikation.

De skeerme i TI-SmartView™-emulatoren til MathPrint™-lommeregnere, som kan
traekkes og indsaettes, omfatter fglgende:

Skaermen over tastaturet i Emulatorpanelet.

Stor Visningsskarm-panel

Gemte eller ikke-gemte skaermfangster i Skaermfangstvinduet
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Tastaturtilknytning

Du kan bruge dit computertastatur til at trykke pa en tast i stedet for at trykke pa den
pagealdende tast pa TI-SmartView™-emulatorens tastaturbillede.

Anvendelse af computerens tastatur

Hvis du vil trykke pa en emulatortast ved hjzelp af computerens tastatur, skal du bruge
tabellen herunder for at se, hvilken tastaturtast der er knyttet til emulatortasten.

e TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™ tastaturgenveje
e TI-30XS-30XB MultiView™ tastaturgenveje

e TI-34 MultiView™ tastaturgenveje
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TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™

Eksempel: Tryk pa [W] pa computerens tastatur som vist i tabellen herunder for at fa
vist tilstandsskaermen.

quit

TI-30X Pro MathPrint™ tastaturgenveje:

TI-30X Plus MathPrint™ tastaturgenveje:

Znd (modie] delete 0] ®
[al [W] | [Delete] [<] [1~]
[In log (math] [data] ® ®
[R] [Tl vl (4 [—>1
(7107 [EE] ) [table] [clear]
[U] [ [P] [A] | [Backspace]
i) (5] 2 =) =
[D] [F] [G] [H] 11
=3 5 | 0]
[J] [K] [l [ [*1
(7] 7 B ] =]
[L] [71] [el [e1 [-1
5 [l H| 8]
[Z] [4] [5] [€] [+]
sto-] [ 2 3] oz
[X] [1] [2] [31 [c]
[on) [0] B (=) [enter]
vl [0] [.] [B] [Enter]
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*Bemaerk:

P& MAC-computerens tastatur:

Tryk pd [Slet] for [delete].
Tryk pa [Tilbage] for [clear].

2nd mode [delete © =
[aj [W] | [Delete] [<] "
* ['1
In log math data @ :D
[R] [T I [=]
el 100 [Eg] (03 table] clear
[v1 D [P [A] | [Backspace]
*
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TI-30XS/30XB MultiView™

Eksempel: Tryk pa [W] pa computerens tastatur som vist i tabellen herunder for at fa
vist tilstandsskaermen.

quit

TI-30X45 MultiView™ keyboard shortcuts:

2nd 0] @
[Ql] [W] [Delete] [<1 (T
or or or
[CEril+ | [Ctri]+[ < ]
[Delete] e+ T
@ ®
[R] [T] [Yl 1 [>]
or or
[Ctri]+] —= 1
ctril[ 1
(in]
[U] [11 [P] [A] | [Backspace]
or
[Ctri]+
[Backspace]
MacE:
[Clear]
[sin] [cos] (=]
[D] [F] [G] [H] [/1
X7 0]
[J1 [K] | [Shiftl+[(] [ [Shift]+[)] [Shift]+[*]
E]] (-]
[L] [7] (2] 91 [-1
(4) (5] (6]
[Z] [4] [51 [6] [Shift]+[ +]
sto* [ 2] 3]
[X] [11 [2] [31] [C]
@ O =)
vl [o] [-1 [B] [Enter]
or
[Ctri]+[Enter]

Bemaerk: Undtagelse pa MAC
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*Bemaerk:

P& MAC-computerens tastatur:

Tryk pd [Slet] for [delete].
Tryk pa [Tilbage] for [clear].

2nd mode [delete © =
[aj [W] | [Delete] [<] "
* ['1
In log math data @ :D
[R] [T I [=]
el 100 [Eg] (03 table] clear
[v1 D [P [A] | [Backspace]
*
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TI-34 MultiView™

Eksempel: Tryk pa [W] pa computerens tastatur som vist i tabellen herunder for at fa
vist tilstandsskaermen.

quit

TI-34 MultiView™ keyboard shortcuts:

2nd ® ®

[al W] [Delete] [«1 p
or or [ 01

[Ctril+ | [Ctri]+[ <~ ] )
[Delete] et T
@ ®
[R] [T] [Y1] (1 [=>1]
or
G N
[ctrilf ]

raimp]
[ul [ [P] [A] | [Backspace]
or
[Ctril+
[Backspace]
MacE:
[Clear]

=]
[D1] [F] [G] [H] [/1
0]
[J1 [K]1 | [Shif]+[(] | [Shift]+[}] [Shift]+[*]
£l =
L1 [71 [8] [91 [-1
(6]
[Z1] [4] [51 [&] [+1

al 2] [E]

[X1] [1] [2] [3] [cl

[on] El =) enter
vl [0] [.] [B] [Enter]
or
[Ctri]+[Enter]

Bemaerk: Undtagelse pa MAC
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*Bemaerk:

P& MAC-computerens tastatur:

Tryk pd [Slet] for (delete].
Tryk pa [Tilbage] for [clear].

2nd mode| [delete] © =
[aj [W] | [Delete] [<] "
* ['1
In log math] [data] ] »
[R] [T] 1| 4 (1
(20100 [Eg] [38] table] clear|
[U] [ [P] [A] | [Backspace]
*
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Generelle oplysninger
Online hjzelp

education.ti.com/eguide

Velg dit land for at fa flere produktoplysninger.

Kontakt Tl Support

education.ti.com/ti-cares

Velg dit land for at finde ressourcer for teknisk support og andre supportressourcer.

Service og garanti

education.ti.com/warranty

Velg dit land for at fa oplysninger om varigheden og betingelserne for garantien, eller
om produktservice.

Begranset reklamationsret. Denne garanti pavirker ikke dine lovbestemte rettigheder.
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